Using GenSmarts Intelligently

May 31, 2011

GenSmaris

Automated Research Advisor

GenSmarts Introduction

GenSmarts is artificial intelligence software that 1) analyzes your existing genealogy family file, 2)
produces research recommendations, and 3) provides a tracking journal log. GenSmarts helps
uncover family history brickwalls whereas traditional genealogy software is focused on providing tools to
document known information. GenSmarts doesn't replace traditional genealogy software (e.g. PAF,
Family Tree Maker, etc.), but analyzes the data that users have already collected and searches for the
missing information via the Internet and other sources. It also creates a comprehensive journal log for
users to track GenSmarts recommendations. The journal log allows users to plan for library or Family
History Center trips and meeting with relatives to research the ancestor’s missing information.

What does GenSmarts do?

GenSmarts develops a profile of your ancestors based on where and when they lived using your existing
family file. This profile is matched with GenSmarts inventory of known records to make suggestions
about the missing data on your ancestors. These suggestions are prioritized and detailed to highlight the
missing data in the family file. Many of the suggestions look at different spelling variations of ancestor’s
names. In addition, GenSmarts navigates the Internet using a sophisticated search engine, typing in your
ancestors’ information and providing the missing data using many web resources.

Agenda

Latest Version 2.0 Upgrade Features To Do List

Using Online Help Research Locations
Research Status Symbols/Filter Box Definitions Data Clean-Up

My Genealogy File Queries

Version 2.0 Features (Latest Update 2.1.1.91 as of May 2011)

GenSmarts just introduced their latest Version 2.0 in April 2009. Version 2.0 includes several new
Internet databases to access besides several new filters. Only the basic features will be explained in this
class, but users can see all the new features after viewing the video tutorials included with Version 2.0.
New users will see a Wizard Box that sets up the program during installation. Existing users will not see
the wizard, which the program is already setup from the previous version.

Several GenSmarts Highlights

Video tutorial for entire software or just Version 2.0 additions
Filtering Box to reduce or eliminate suggestions

Classic Version 1.0 screen option included

Comments Box with dates
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New filtering formats using Advanced Filtering Wizard
More Internet databases included
And many more features!

Using Online Help

GenSmarts has several options to help any user on any screen or definitions. Like most programs, the
internal Help Index is very helpful. Select the Help menu item on the top menu bar and select GenSmarts
Help, which routes the user to a Help Index. Select either a topic or type in a phrase for the required help.

For more complex help situations, GenSmarts has an online common question tutorial help reference.
Select either Frequently Asked Questions in the Help menu or select the Confused? Click here for Help
box in the upper right hand corner. An online GenSmarts topic box gives users access to many common
questions or allows up to type in more specialized questions.

Icon Symbols/Former Filter Box Definitions

The filter box has been changed and moved in Version 2.0, but the older style box is available for users
wanting the former ‘Classic’ style. The new suggestion/filter box is located above the ‘To Do List’ using
a pull down menu.

The Research Status indicator icon symbols and older filter box definitions are listed below for tagging
the research results or filtering the results to narrow the amount of listed items in the Research To Do
List.

Show All: Selecting ‘Show All’ removes any filtering by these check boxes - the whole list is displayed,
constrained only by the "<= Search" box, if you've typed a phrase there.

Found: Selecting this symbol/filter box (green checked square) next to the selected item removes this
from future searches and eliminates any duplication of researching this item again.

Not Found: Selecting this symbol/filter box (red scissors square) next to the selected item keeps this
research item in the list to research later.

Plan to Search: Selecting this symbol/filter box (blue square) indicates no information has been found
and the user needs to research this item in the future.

No Status: This symbol/filter box indicates nothing has been done.

Ignored: Selecting this symbol/filter box (red scissors) indicates the information is probably incorrect
from the GenSmarts analysis.

Available Online: This symbol/filter box (green & red mouse) indicates research information is available
online using different databases, but you may need a fee-based subscription to access it.

Available to You Online: This symbol/filter box (green mouse) indicates you have either a free or fee-
based subscription available to you for searching selected individuals.
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Fills Missing Data: This symbol/filter box (green smiley face) indicates only ancestors with missing data
not found in your family file will be displayed in the ‘Research To Do List.’

Direct Ancestors: This symbol/filter box (blue star) indicates only ancestors tagged as direct ancestors
(blue stars) will be displayed.

My Genealogy File Tab

After automatically analyzing your family file associated with your existing genealogy program, a list of
ancestors is displayed in the People box as shown in Figure 1 below. Type in ancestors full name or last
name in the People box or select the ID number [in brackets] associated with the last name.

[1] The family file data will be listed in the top left area of the screen and the file facts will be listed in the
top center area as shown below.

[2] On the upper right side, vital facts are given for the selected individual. Sometimes, GSEST will be
displayed. This indicates GenSmarts has given an estimate of dates and locations for unknown records of
that ancestor.

(& GenSmarts Version 2.1.1.83 Coffin - Pierson Family 12-1-07.FTW
Eile Print/Export Tools Wiew Help
Confused? Click here for help

My Genealogy File | To Do List 1 Research Locations 1 Data Cleanup I Queryl

File Facts Data Facts
File Mame: F:\2007VCoffin - Pierson Family 12-1-07 FTvy /zzrr:;:rollnwwduals. 281
" e e Number Of Familes: 146
Date Madlfice 11412040 :36:28Flle Size: 543487 N~ 1 e ot
Ppeople People Facts: / 2 \
| <=Gearch  &MaliCopy Coffin, William H. [3] (B.1835 D.1893)
Coffin, Gale Hampton [247] (1900 D.1969) + | William H. Coffin [75]: He was born on 25-JUL-1835 in Dumnesburg, Schenectady Co., Nev York, and he died on 14-JUN-1893 in .
) . ) Charles City, Floyd Co., Towa. He married Awanda Eliza Allen [76] on 30-DEC-1857 in Charles City, Floyd Co., Iowa, and had
Coff!n, Harriet Hatfie Ann [59] (1860 D.1941) the following children: Agnes [77] (1858), Harriet [69] (1860), Williew [78] (1863), Darwin [78] [1865), Luella [81]
Coffin, Harry Angelo [$7] (B 1906 D.1989) (1867), and James [80] (1870). His parents were Michael Samuel Coffin [242] (b. GSEST. 1811, d. GSEST. 1877), and
Coffin, James Cecil [80] (B1870D.1938) Elizaheth Wiltsee [101] (b. 6-JUN-1809, d. 22-MAR-1887 in Charles City, Floyd Co., Iowa).

Coffin, Lilas Lily Bell [$9] (B1839 D.1967) \
Coffin, Louise [96] (B.1903)

Coffin, Luella [81] (B.1867 D.1839)

Coffin, Luella b, [92] (B.1885 D.1976)

Coffin, hMark Daniel [356] (B.1963)

Coffin, Michael Samuel [242] (B 1811 D.1877)
Coffin, Meenah [95] (B.1887 D.1975)

Coffin, Roy Scott [362] (B.2000)

Coffin, Scott Michael [360] (B.1968)

Coffin, Stephen [99] (81847 [.1900)

Coffm Wayne James [90] (B.1887 D1958)

liam H. [75] (B.1.
Coffm william Hamilton [246] (B. 1898 D1975)
Coffin, William J. [78] (B.1863 D.1944)
Conner, Glenda Ann [123] (B1971)
Cornell, Frederick [350] (B.1914)
Cornell, Frederick Robert [351] (E.1935)

Cornell, Kimberly [370] (B.1957)

Co ert Blair [363] (B.1957)
Da 3 e [231] (B.183% D.1907) 4
D | Ann [384] (B.1942)

Denms Dawd [283] B 1942) / il
i3 Direct AncWftor Tag: 5
Tag As Direct Ancestor Root | | Finel Nest Root

Figure 1. My Genealogy File View

New family files won’t have any direct family tags (blue stars) listed next to each individual. Users can
tag selected individuals with the blue stars for direct relationships as shown above using the [3] Tag As
Direct Ancestor Root button. You can remove the blue stars anytime mistakes are made, by selecting [4]
Clear Tag next to the mistaken individual.
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Select [5] Find Next Root to find the next direct ancestor to the selected individual. Users need to select
the next generations with these tags (blue stars) to see higher levels of direct relationships displayed.

To Do List Tab

This is the best feature of GenSmarts. First, it finds all the missing data for you so you don’t have to keep
backtracking your family file. Second, if available online, GenSmarts will search several databases to find
your selected ancestor. This is a time saving tool as users just watch the program search for ancestors
without typing any information. After analyzing the family file, the results will show how many
suggestions are displayed in the box for all ancestors as shown below in Figure 2. Typically, hundreds to
thousands of results can be displayed.

l’r‘ GenSmarts Yerzion 2.1_1.10 coffin - prerson Family. 6-1-0F_ftw
File Print/Export Tool: Yiew Help

1 \ 3 Confused? Click here for help. ‘
My Genealogy File To Do List I Research Locations ] Data Cleanup l Query] ¢
Research To Do List 1,062 Supgestions Displayed J LEGEND ~
fi 4_ - i i -
|ShowMSuggesﬁo.-ls ? J |Sor19d by Research Priority J Available Online

ﬁ [

Awvailable Online(Fee)
Missing Data

Missing Source
Direct Ancestor Foot
Direct Ancestar
Found

Y m-.HCoﬁ'm':-
% Michigan 1880 Census for Michael Samuel Coffin [242
U@ Flgwa 1980 Census for Thadius C. Pierson [F2]
BE  Flowa 1880 Census for Elizabeth Wiltsee [101] (Cofiin)
BE  FMew York 1880 Census for Elizabeth Wiltsee [101] (Coffin)
B8 ¥ Minnesata Death Recards riet Hattie Ann Coffin [69] (Fierson) Mot Found
BE  FMew York Cermetery/Burial 8 ds for Michael Sarmuel Coffin [242] F'Izn Toc-ugearch

BE Flnwa 1900 Census for Thading C. Piersan 771
t/ Research Link
Upddte Research Status, Mark As... \ Last ypclated: 19-Mayw-2007
| Mot Found | Plan To Search ‘ Ignare ‘ Revisit Later ‘ Clear Status ‘ Available Online!

|Shuws entire family with middle initials.

fOER 0 + 0o

Comment:
— Explanation 1 6

lowa 1880 Census for William H. Coffin [75] 7

-

Why?

Researching the lowa |#H0 Census makes sense because his child, Jarmes Cecil Coffin [B0], was born in 1870 in Charles City, Flovd
#d, Harriet Hattie Ann Coffin [69], was married in 1882 in Charles City, Floyd Co., lowa, The 1880 census is
important becaus/it contains birthplace information for parents of the people listed, as well as the relationships between people living

in the househ

Co., lowa and his ©

Missing Data hd

Figure 2. To Do List Typical Research Suggestions

Users can narrow search criteria by selecting certain criteria at the top of the [1] Research To Do List
using the box that [2] Shows All Suggestions. GenSmarts, by default shows all possible combinations of
search results. [3] Users can notice the amount of suggestions above the list box.

Tip: To narrow this list, select one of the other various suggestions using one of the filters. Select [1]
‘Suggestions by a person.” Users will notice the [3] amount of suggestions will be reduced substantially.
A new dialog box appears as shown below in Figure 3, then type in the individual you want to view or
highlight the name below and select ‘OK.’



Using GenSmarts Intelligently

Select A Person ®

Highlight the person of your chaoice and then press Ok (or
CANCEL to select nothing).

People

|C0fﬂ n, | <= Search

tCoffin, Harriet Hattie Ann [69] (B.1360 D.1is
Coffin, Henry 4. [97] (E.1907)
Coffin, Jawes Cecil [S0] (B.1870 D.1938)
Coffin, Lilas Lily Belle [88] (E.185% D.1946°
Coffin, Louise [96] (B.1503)
Coffin, Luella [§1] (E.1867 D.1853)
Coffin, Luella M. [92] (B.1885 D.1938)
YrCoffin, Michasl Samuel [242] (B.1811 D.1877
Coffin, Neenah [25] (E.1857 D.1940)
Coffin, Stephen [99] (E.1847 D.1900)
Coffin, Wayne James [90] (BE.1557 D.1940)
%Coffin, Willism H. [75] (B.1835 D.1593)
Coffin, Williem Hamilton [246] (E.1893)
Coffin, William J. [73] (E.1363 D.1944)

»

QK Cancel

Figure 3. Index of Individuals

[4] Selecting “Sorting by Research Priority,” or surname, date, geography, and record type can also
reduce amount of items in the research list in the next dialog box. Research Priority is the default sorting
method. This allows users to concentrate on a single individual and eliminate all possible research
recommendations and find additional data not in your family file. This is particularly helpful to new and
intermediate users, not knowing the next step in genealogy research.

[5] From this list in figure 2, review each item having missing data. [6] Notice the explanation box at the
bottom to see what information is is analyzed by GenSmarts. Next, [7] select the Research Link on the
right side, which can be shown as Available Online or Trial Offers. Selecting Available Online will
automatically select SmartLink or SmartSearch to find the database that users subscribed to. Other
databases can be selected if you know their website addresses by using the Query tab or adding a new
subscription. Trial Offers requires a free trial subscription to fee based genealogy websites for 30 days or
less. After completing the required information, access is allowed in Trial Offers.

Tip: If you already have a fee based subscription to Ancestry.com, Genealogy.com, Footnote.com,
Archives.com, NEHGS, or other service including Heritage Online (remote library access only), but
haven’t entered it yet, then select the ‘“Tools’ menu item and select ‘Settings’ and ‘Subscriptions’ tab at
the top of the box, then select what subscription service is used. You’ll be prompted to enter the user
name and password for the selected service in a new box. Even if you don’t subscribe, the subscription
based services will give you results without the images. Then you can decide if there are enough results to
merit subscribing to their service.

After selecting the Research Link and reviewing the database record, [8] select the appropriate
symbol/icon in the Update Research Status box to mark that selected item as shown above in the list. The
list makes a nice journal log for you to track ancestors in the future for use at a genealogy research library.
Users can type in comments for each item and save or print the entire list or just for an individual from the
top menu bar. After saving and closing the GenSmarts program, the completed tasks will be eliminated.
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Printing To Do List

A printed To Do List is similar to a journal log in tracking all the past research events to prevent
duplication and extra work. When users visit a research library or other facility for genealogy research,
GenSmarts creates a tracking journal log from the To Do List. You can narrow the list by using the
specific library, if it’s included in the GenSmarts Research Locations list as shown below in Figure 4.

After users have sorted and filtered the list to eliminate extra items not needed or make any adjustments,
then simply select File and Print To Do List. Your printer dialog box appears, then select OK.

Research Locations Tab

GenSmarts provides information about the research facility and its contents from its internal directory as
shown below in Figure 4. Users can [1] type in their favorite genealogy research facility or select from the
research facilities list. [2] The address is shown as a reference. Selecting the required item in the [3]
Available Research Items will give users more information on the selected item in [4] Research
Comments in the lower right box.

l'l“ GenSmarts Yersion 2.1.1.10 coffin - pierson family 6-1-07_ftw

File  Print/Export Toolz “iew Help

Confused? Click here for help. |

My Genealogy File l To Do List Research Locations | Data Cleanup ] Quer]r]

Research Facilities 1 Facility Facts
< | ic L
/ <= Search Allen County Public Library
F - 200 East Berry Street
-
9EI1 nsusOnIln Wehsne/ FortVayne, N a0z € —| 3
Allen County Public Library
Ancestry.com Wehsite
Arizona Gov Website
Ash Grove Library
Automated Genealogy
BYU - Idaho Genealogy Website
Brentwaood Library i
Mamdantnn Mamdan Ta | ikrare v WWW Link
Available For Research At The Facilities Selected Above Research Comments  ¢——— 4
<= Search Thiz information might be found on 1 Book at the Allen County Public

Likrary. The volumes for these are:
Pierce Washington County Birth Records for Steven Michael Samples [35] \'\ v

Carroll Indiana County Birth Records for Harriett Evelyn Pollack [42) Call Mo: 977 201 M33DA0 Title:Marion Courty, IN, birth records
Carroll Indiana County Birth Records for Mary Elizabeth Pollock [46]
Cass Indiana Courty Birth Recards for Edward Kasner [41]

Cass Indiana Courty Birth Recards for Augusta Casner [267]
Caszs Indiana County Birth Records for Frances Kasner [268] > 2
Cass Indiana County Birth Records for William Kasner [259]

‘Marion Indiana County Birth Re : fo 3

Miami Indizna Courty Birth Records for Charles Hall [1 02]
Wayne Indiana Courty Birth Recards for Robert Arthur Roll [148]
lowva 1885 State Census Records for William H. Coffin [75]

lowwa 1885 State Census Records for Charles L. Morean [33] J‘V

Figure 4. Research Locations View

The [2] Available Research Items are GenSmarts suggestions based upon what known or possible
records exist at the selected research facility. The Research Comments gives information on known
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documents existing at the selected research facility. Documents include books, genealogy publications,
microfilm, or family files.

Data Clean-Up Tab

There will likely be unknown errors in your family file. GenSmarts helps to find these errors and gives
you the option for corrections selecting the [1] Data Cleanup tab as shown below in Figure 5. There are
[2] three categories for interpreting the error results: 1) Place Names, which lets you review how
GenSmarts is interpreting the place name errors in your file, 2) Save Issues, which displays any issues
GenSmarts has in loading your direct ancestor settings or in loading your saved research results, and 3)
Estimating, which displays any issues that GenSmarts estimated any missing dates and places in your
family file.

This Place Names tab contains a list of place names where you may want to check GenSmarts
interpretation. In some cases, GenSmarts has been able to figure out [3] location specifics, but only by
making assumptions you may wish to investigate. An example for a place name like "Clark, IN," where
GenSmarts interpreted this to mean "Clark, Lake County, Indiana, USA." There's also a Clark County,
Indiana, so GenSmarts will show both places for users to select the correct one.

rt‘ GenSmarts Yersion 2.1.1.10 coffin - pierson family 6-1-07_Fhw

Eile Print/Export Toolz “iew Help

/ l Confused? Click here for help. ‘
My Genealogy File l To Do List ] Research Locations Data Cleanup IQueryl
|Coffin, William 3 | <=Eind Next ‘ Help On Place Name Data Cleanup ‘
Frop Yow Fleerm—— )/ > | Gensmarts interpretation ”

Fi rﬁssing far death event for Coffin, Michael Samuel [242] (B.1811 D877 LOCL DIV2: Schenectady DIV MY COUMNTRY: US4
F1 Mis=zing for bitth event for Coffin, Michael Samuel [242] (B1811 DASTT) LOCL DIW2 DIV MY COUNTRY: USA

F1 Mizzing for death event for Coffin, Meenah [95] (B.1887 049400 LOCL: Di%2: Flowd DI 14 COUNTRY: US4
FI Miz=sing for death event for Caoffin, Stephen [99] (B.1547 ©.1900% LSCL: DIY2: Schenectady DIV MY COUMTRY: US4
F1 Miz=sing for hirth event for Coffin, Stephen [99] (B.1547 D1900) LSCL: DIY'2: Schenectady DIV MY COUMTRY: US4

LOCL D2 DIV Wil COUNTRY: LIS A
. DIW2: Floyd DIY: 14 COUNTRY: USA

Fi Miszing for death event for Coffin, VWayne James [90] (B.1537 D.1340)

F) Mis=ing for marriage event for Coffin, Wiliam J. [78] (B.1863 D.1944) an:
F1 Miz=sing for death event for Day, Sara Jane [231] (B.1838 0.1907) LSCL: Div'2: DA 1S COUNTRY: US4

IEu!wmgsg l SINSS| ARG | sawey ade|d

F1Miz=sing for birth event for Densmare, Patricia [131] (B.1950) LOCL: DIY2: Bl Paso DIV COCOUNTRY: USA

F1 Miz=ing for death event for Dogan, Emily [48] (B.1825 D 18587 LOCL: D2 DIV KBS COUNTRY: USA

FI Miz=sing for birth event for Duffin, Thomas [255] (B.1554 01948 LSCL: DIY2: Petroleum DIV T COUNTRY: USA

F1Mizzing for death evert for Duffin, Thomas [255] (B.1554 D.1945) LoCL: DIY2: Fergus DIV MT COUNTRY: US4 e
< >

. ._:Exlllanatmn 7 4

Genfmarts estimated this place name for you, based on other events. To correct itc, o~

please specify a place name for the marriage ewvent for Coffin, Willism J. [75] (B.1l8563
D.1944) and Meyer, Paulina [82] (E.1866 D.1957). The place name used by GenSmarts for
this session will be:

Floyd, Iowa

Figure 5. Data Cleanup Place Names Results

The key information saved is the name of the person, the birth date and place, and the death date and
place. If the name and one of the birth date/place or the death date/place matches, then GenSmarts will not

7



Using GenSmarts Intelligently

display any issue. If the name matches, but neither the birth date/place nor the death date/place matches
then GenSmarts will warn users. GenSmarts will also display an issue if the name doesn't match.

Users will notice [3] letters on the left side assigned to each issue, which are assigned by categories:

A) GenSmarts was unable to obtain any geographical information

B) GenSmarts was only able to use a portion of the geographical information present

C) GenSmarts noted that users haven't recorded the place names yet

D) GenSmarts was able to supply some additional geographic information, based on the city

E) GenSmarts was able to supply some additional geographic information based on the county or state
F) GenSmarts estimated a place that was missing from the user’s data

In the GenSmarts Interpretation display, [3] different geographic divisions are shown as follows:
Country
Div1 - the level of division below country (in the USA this would be a state, in England, it would be a
county)
Div2 - the level of divsion below Divl (in the USA this would be a county)
Locl - any further locality information from your file (city and any additional information imported)

The [2] Save Issues tab within the Data Cleanup tab lets you review and correct these types of issues.
Users can delete the offending mark/tag.

In the [2] Estimating tab, GenSmarts uses a "jury™ algorithm to estimate any missing birth, marriage, or
death events in your file. Other events in a person's life that have established dates, will reason with each
other to reach a consensus estimate for the missing date. If the established dates become deadlocked, it's a
sign that some of the dates for events in this person's life are likely illogical. There are two types of
conditions that show up in the list:

1. llogical conditions encountered during estimating, as described above
2. Possible living person, not marked as living (if your file format supports this mark)

The [4] explanation box will contain a chronology of the estimated dates or locations from known data. If
an illogical situation was detected, it will indicate as such for those affected dates.

For dates that were estimated successfully, users will find some narrative in the My Genealogy File tab,
within People Facts for the person in question. This area shows the dates that were used to produce the
estimate.

Query Tab

The Query tab allows users to search for suggestions that are not based on any family file data. This is
helpful 1) if users don't have an ancestor in a file that's currently available, 2) users simply don't want to
take the time to load their family file, or 3) users want to try some place names or dates that differ from
their family file.

After completing the Query entry box, users will obtain the results as shown below in Figure 6. The more
information completed on the specific ancestor will narrow the results.
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The resulting suggestions are displayed in a subsequent window when users select the Generate
Suggestions button. These suggestions are independent of your To Do List tab, and are not saved after
closing this tab.

If information is available on the Internet, then the mouse symbol will be listed as shown above. If not,
then a trip to local libraries or local Family History Center will probably be required.

Query Besults 3]
Research Suggestions
: I
U  lowa Marriage Records for Amanda Allen (m. william H. Caffin)
“BE  lowa Marriage Records for william H. Coffin (m. Amanda Allen)
“B Mew Y ork 1850 Census for william H. Coffin

‘B lowwa 1850 Census for william H. Coffin

‘B lowa Cemetery/Burial Records for Amanda Allen (Coffin)

“BE  Floyd lowa Newspaper Obituaries for william H. Coffin
B
‘B
!
B

Help

lowa Cemetery/Burial Records for william H. Coffin
lowa Land Patent for william H. Coffin Research Link

lowea Civil War Service Records for william H. Coffin
lowa Directory for william H. Coffin " I

Explanation

lowa 1880 Census for william H. Coffin
Fesearching the Iowa 1830 Census mwakes sense because he was warried in GSEST. ~
1554 in Charles City, Iowa (Floyd County) and he died in 1893 in (G3EST. Flowd
County, Iowa). The 1880 census is iwportant begcsuse it contains birthplace
information for parents of the people listed, as well as the relationships
between people living in the household.

Gendmarts has hypothesized & DATE and & FPLACE for vyou (indicated by the G3IEST.
prefix) to come up with this suggestion. The basis for these hypotheses were:

GAE3ZT. Flovd County, Iowa was estimated bhecause he was married in G3EST. 1554 in
Charles City, Iowa (Floyd County) . v

Figure 6. Query Results View
Use the Clear button if you'd like to reset all the fields to their default values (blanks in most cases).

Users can also get to the query tab by double clicking on an ancestor in your My Genealogy File tab. In
this case, the query data will be defaulted to the data from your family file. Any changes made to this data
will affect this query only, and will not change your family file or the data used from your file in other
parts of GenSmarts.

Saving GenSmarts Information

When users tag a person in your file as a direct ancestor or when users mark a research result, GenSmarts
saves key information about the individual involved. The tag/mark can be shown during the next time the
same file is displayed. If key information changes in the family file, GenSmarts may have a problem
trying to match the tag/mark. When GenSmarts isn't able to match a direct ancestor root or research result,
the tag or mark continues to be saved. However, it won't be displayed when a match isn't made.
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The Save Issues tab within the Data Cleanup tab lets you review and correct any of these types of issues.
Users can delete the offending mark/tag.

Frequently Asked Questions

What genealogy software does GenSmarts work with?

- - Family Tree Maker 2010 - Ancestry Family Tree
- PAF5 - Brother's Keeper (Version 6)
- The Master Genealogist - Family Trees Quick and Easy (contact us)
- RootsMagic 4.0 - Heritage Family Tree Deluxe (contact us)
- Legacy 7.0 - Any Gedcom export file
- Ancestral Quest (replaces PAF) - Ultimate Family Tree

Since Gedcom files can be detected, virtually any genealogy software can be used with GenSmarts,
provided the genealogy software has the ability to export Gedcom files into GenSmarts. It’s a manual
process but still works with most genealogy programs not listed above. GenSmarts Version 2.0 will work
on Windows 98 through the latest Windows 7 operating systems. No support for Apple Maclntosh, unless
you use PC emulator software.

Do | have to be online to use GenSmarts?

No, GenSmarts still works without being connected to the Internet. However, users won’t be able to
search Internet database records on their ancestors without being connected to the Internet.

Where can | obtain GenSmarts?

Users have two options: Try the limited trial version by downloading from the GenSmarts website for 30
days at: www.GenSmarts.com. The trial version is an 8 MBS file, which will take less than 3 to 5 minutes
to download using cable or DSL broadband or about 20 minutes with older 56 KB telco modems. Users
have 30 days to evaluate the trial version. Download the FREE manual in PDF format for more
information.

Option Two: For all other genealogy software users, purchase directly through GenSmarts or
Ancestry.com Store for $29.95. Credit cards are accepted.

Are updates free?
Yes, all updates to the version you purchase are free. If you purchase Version 2.0 and Version 2.5 is
available, that would be a free upgrade. GenSmarts reserves the right to charge a nominal upgrade fee for

the next major version upgrades, ie, Version 3.0.

Try the trial version to see if you can find answers to your brickwalls and create a research journal. If you
like the software, you can purchase it after a 30 day trial period.

Good luck on your research and Happy Trails!
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